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Introduction
Welcome to Lyra! This program is designed to be an easy way to compose music on your 
PC. Lack of music keyboard skills is not an impediment. You can easily write or transcribe 
music using a mouse. The music is displayed in standard notation, just like sheet music. Or 
you can use the program to just play music.

A quick way to become acquainted with Lyra is to read the help pages in sequence by 
pressing the > key which will advance the display to the next page. You also can position 
the cursor on different parts of the Lyra window and get a description of the area by 
pressing the F1 key. 

This Windows version of Lyra is being distributed as "shareware". If you find the program to 
be useful, please help support its continued development by paying a registration fee of 
$20. In return, you will be sent a copy of the latest version and given the opportunity to 
receive updates for a small fee. Your input is welcomed; if you have suggestions for new 
features or notice that things don't seem to work right or are unnecessarily difficult to use, 
please let me know.

Please direct all comments, suggestions, and inquiries to:

Lester Hands
MusicWare
Hamlet Rt. 1261
Seaside, OR 97138

Lyra is copyright 1993 by Lester Hands. Permission is given to distribute copies of this 
program and supporting files provided that no changes are made and no charge is made 
for the program. A nominal charge may be made for the distribution media. This program 
may not be included with another program or product without the written permission of the
author.

Special thanks to the folks at Borland International for their excellent Pascal compiler, and 
to the many users who have provided feedback and impetus to make improvements.



What you need to run Lyra
Lyra requires a computer that can run Windows 3.1 (or a later version); if you wish to play 
music, you must have a Windows compatible sound card such as a Sound Blaster or a MIDI 
interface card such as an MPU-401 and a MIDI capable synthesizer.

Windows comes with the necessary software needed to work with a Sound Blaster or MPU-
401 card. All that you have to do is to follow the directions in the Windows manual to make 
sure that the needed driver is installed and properly configured.

If you are using a different sound card or MIDI interface, then you may need to install 
special drivers. These drivers are usually supplied by the manufacturer on a disk. If you 
don't have such a disk, contact the manufacturer.

This version assumes that Windows is running on a VGA monitor with a resolution of 
640x480 or higher.



What Lyra Can Do
Lyra is like a musician's word processor. With it, you can enter music into the computer and 
then play it back. Since you are working with standard musical notation, it is easy to work 
with if you already know how to read music; it you don't, you will find that you will learn 
quickly!

Lyra is a playback sequencer. That is, it will play a sequence of notes but cannot record 
music from a MIDI keyboard. The best way to think of Lyra is as an eight voice choir. Each 
voice in the choir corresponds to a track in Lyra. Just as a voice can sing only one note at a 
time, each track is limited to one note at a time. Chords are possible, but you have to split 
the notes up between the tracks. This may seem limiting, but you will find that it makes 
entry and editing of music very simple.

Lyra has provision for controling how your music will sound. You can easily vary the tempo 
(the speed at which it is played), the volume, and the instruments sounds produced by 
each track. This means that you can play music that has a good deal of expression.



Window Description
The Lyra window is divided into five main areas: 

the menus at the top
the current file name just below the menus at the left,
the tape controls to the right of the file name
the track selection boxes on the far right,
the music score in the middle,
the tool box in the middle below the music score,
and the help bar at the bottom.



File Name Area

The file name area at the top left tells you the name of the file you have opened. It is 
changed when you open or save a file.

Clicking on the file name will bring up the File Load dialog box, giving you a short cut to 
loading in a new music file.



Tape Controls

The tape controls, which are located at the top of the window in the middle, give you 
controls that are similar to the traditional tape recorder controls that most people are 
familiar with. There are six controls: reverse (jump to the first measure of music), play, stop
play, forward (jump to the end of music), go to a bar number, and turn all notes off. If 
you're not sure what each control does, simply point the cursor at the control in question 
and look at the help bar at the bottom of the window. If no description appears, it is 
because the control is disabled until music playback is started.

While music is playing, the controls that cannot be selected turn gray and the go to control 
turns from green to red. While it is red, clicking on it will stop the music at the currently 
displayed screen. If you stop music by clicking on the stop play, the music display will 
return to the measure that you started from.



Track Selection Boxes

The track selection boxes on the top right normally are all gray with black numbers inside. 
Lyra uses eight tracks, and each track can be thought of as a vocal part in a choir, or an 
instrument in a band (such as a flute, sax, or trumpet). In order to enter or edit music, you 
must first select a track so that Lyra knows where the music is supposed to go.

Clicking on a box makes the colors reverse for that box and the music display changes so 
that only the notes for the selected track are black, and all the rest are grey. This can be 
used to simplify the display when you have a dense score, and it can be used to assist you 
in editing music.

Clicking the right mouse button on a track box will bring up a dialog box which will let you 
configure a track. This allows you to set the MIDI channel, master volume, transpose, 
instrument, and pan.

You may also select a track box by pressing the control key with the number of the desired 
box. For example CTRL+3 will select the third track. Adding the shift key will bring up the 
track configure dialog box (such as SHIFT+CTRL+3).

While music is playing, you may still select any track but you cannot call up the track 
configure dialog box.



The Musical Staff

The musical staff is the place where notes and rests are placed. The vertical position on the
staff is the way the pitch of a note is indicated. The higher on the staff, the higher the pitch.
The horizontal position shows the time progression of the music, reading from left to right.

Lyra makes use of the grand staff, which is made up of the treble clef and the base clef. You
will notice that the horizontal lines on which notes are placed are organized into two 
groups: the upper group starts with the treble clef symbol and the lower one starts with the
bass clef. These clef symbols are used to indicate what pitches are associated with each 
level on the clef.

As you move the cursor up and down over the grand staff, watch the help bar at the 
bottom of the window. It will tell you the pitch name (such as A, B, C, D, E, F, or G) and the 
octave number.

More information about how to enter music can be found in the edit music topic.



The Tool Box

The tool box in the middle at the bottom of the window, contains a number of tools that will
help you in creating and editing music. A tool may be selected by clicking on it with the 
mouse.

The tools are organized into several groups. The top group consists of notes and rests. 
Select one by clicking on it. Only one note or rest can be selected at a time. Pressing keys 1
through 7 will select a note, and SHIFT+1 through SHIFT+7 select the corresponding rest. 
The cursor will change shape to correspond to the note length selected when it is within the
area of the music staff.

The tools on the bottom line consist of four groups. First are the pitch modifiers, or 
accidentals. These tools (sharp, natural, and flat) will modify the pitch of a note. Selecting 
an accidental tool that has already been selected will result in its being unselected. If a rest
is selected, these tools are not selectable. Only one of these tools may be selected at a 
time. Pressing keys S, N or D, and F will select the sharp, natural, or flat tools. A pitch 
modifier will remain selected after entering a note if the Persistent Note Modifiers box 
has been marked in the Preferences dialog box.
 
The next group is the length modifiers (triplet, dot, and tie). These will modify the length of 
a note or rest. Pressing keys , (comma), . (period), T or / (slash) will select the triplet, dot, or
tie tools. Selecting an accidental tool that has already been selected will result in its being 
unselected. You may select any combination except that when a rest has been selected, a 
tie may not also be selected. A length modifier will remain selected after entering a note if 
the Persistent Note Modifiers box has been marked in the Preferences dialog box.

The Select tool is used to mark a block of music that can be Copy or Cut. It is the cross 
shaped tool in the middle of the bottom row. When it is selected, all other tools are disabled
and the cursor changes into a cross while in the staff window. This tool may also be 
selected by pressing the space bar key. The start of a block is marked by selecting a track 
and clicking on a note; that note and the following ones in that track turn red. Mark the end
of the block by clicking on the last note. A block may be deselected by simply clicking on 
the first note in the block.

The last group of tools are used to enter special symbols into the score which change the 
volume, tempo, and the like. All of them can have more than one value, so the Help Bar will
tell you not only the name of the option but also the value that you selected. When you 
click on the music score, a special symbol will be entered. Instead of playing a note, this 
symbol will do something else like changing the volume, tempo, or the sound your 
synthesizer makes.

The first option tool is the Volume tool. When you click on it, a pop-up menu appears, listing
all of the available volume symbols. When you release the mouse button, the volume that 
was highlighted is selected and can be entered into the music. The Help Bar will display the
message Ready to enter Volume pp (or whatever volume you selected) while the cursor 
is in the music score area. More information about volumes in Volume Settings.



The next tool is the Tempo tool. When you click on it, a dialog box appears, asking you to 
enter a new tempo. This tempo is the number of quarter notes per minute. To remind you of
what tempo you entered, the Help Bar will display the message Ready to enter Tempo 
100 (or whatever tempo you entered).

Next is the Octave tool. Clicking on it will pop up a menu with two choices: 8va or loco. 
8va is used to raise or lower a track by an octave. Placing the marker above the music staff
will raise the track an octave; placing it below the music staff will lower it an octave. loco is
used to cancel the effect of the 8va and can be placed anywhere on the staff.

The Instrument tool is supposed to look like guitar. It will let you insert instrument changes 
in your music at any point. It is very important that the Instrument Dialog be correctly set 
up so that the right program change number is associated with each instrument name. 
When you click on the tool, a pop-up menu will appear, listing all of the available 
instruments. When the cursor is on the music score, the Help Bar will tell you what 
instrument you selected.

The next two tools bring up a dialog box which lets you change the key and time 
signatures. This version allows only a single key and time signature; future versions will 
allow changes at any point.

The last tool, the Controller tool, is like the Instrument tool. When you click on it, a menu 
will pop up listing the available controllers. You must fill in the Controllers Dialog to define a
controller.

You can move the tool box around by clicking on the top part of it (where the words "Tool 
Box" are) and dragging it to a new location. Lyra will save the position of the tool box when 
you exit the program; when you start Lyra later, the tool box will be restored to the 
previous position.



The Help Bar
The help bar is a gray bar that goes across the bottom of the window. Its purpose is to 
assist you by telling you what sorts of actions are possible, depending upon where the 
cursor is.

You will find more complete descriptions of Pulldown Menu commands here; as you move 
the cursor over the track boxes, the music score, and the tool box, you will find specific 
information as to the track number, the pitch on the score, and the type of tool you 
selected.



Using the Keyboard
Almost every function of the mouse has been duplicated with the computer keyboard. Here 
is a list of the valid key press commands (other than those associated with the pulldown 
menus):

C - open the controller editor dialog box
c - select the controllers tool
d - select the natural tool (alternate for n)
f - select the flat tool
I - open the instrument editor dialog box
i - select the instruments tool
k - selec the key signature tool
m - select the time signature tool
n - select the natural tool
o - select the octave tool
p - play music
r - select the tempo tool
s - select the sharp tool
t - select the tie tool
V - open the volume editor dialog box
v - select the volume tool
12345678 - select a note length
SHIFT+12345678 - select a rest length
CTRL+1234567 - select a track
CTRL+SHIFT+12345678 - open the track editor dialog box
, - select the triplet tool
. - select the dot tool
/ - select the tie tool (alternate for t)
enter    - enter a note or rest
up arrow - move the cursor up one step on the music score; if you press the SHIFT key as 
well, you can adjust the cursor more precisely.
down arrow    - move the cursor down one step on the music score; if you press the SHIFT 
key as well, you can adjust the cursor more precisely.
page up - move the cursor up one octave on the music score
page down - move the cursor down one octave on the music score
home - move the cursor to the left hand side of the window
ctrl+left or ctrl+right arrow - back up or advance one page



Editing Music
Notes may be easily placed on the music staff by selecting the desired note or rest length 
from the toolbox and clicking on the music staff. Just as easily, you can make changes to 
existing music. 

Entering New Music
Changing Existing Music



Entering Music
To enter new music into a score, you must first select a track. Next select a note or rest 
from the toolbox at the bottom of the window. Select any pitch or length modifiers you 
wish. Now position the cursor on the music staff at the correct pitch and click the left 
mouse button (or press Enter). A new note or rest will appear on the staff. Add as many 
notes as you wish. Each track is limited to one note at a time, so if you wish to enter 
chords, you will have to split the notes between the tracks. 

Here is an example of two four note chords: the notes have been entered into tracks 1 
through 4. Since the first two beats of the measure had only a melody (which was entered 
into track 1), tracks 2 through 4 started out with half rests. Track two was selected, making 
its notes black, and the rest gray. 

A note may be inserted between two existing notes in the same track by clicking between 
them at the right pitch. If you click directly over a note, then that note will take on the 
attributes selected in the toolbox. 

If you click after the last note in a track, then the new note will be added immediately after 
the last note, regardless of how far to the right you click. 

Please note that new notes cannot be entered unless you have first selected a track!



Changing notes
A note's pitch may be changed by dragging it to a new pitch. This is done by putting the 
cursor over it, pressing the left mouse button and holding it down, moving the cursor up or 
down to the new pitch, and releasing the mouse button. The cursor will change shape while
a note is being dragged. If no track has been selected, you must position the cursor directly
over the note before dragging; if a track has been selected, then the note that is black 
directly above or below the cursor can be dragged. You will find that dragging is easier 
when a track has been selected. If you move the cursor too far to the left or right, the pitch 
change will be cancelled and the cursor will return to its normal shape.

You can change a note's length or change the accidental by selecting the desired length or 
pitch modifier in the toolbox at the bottom of the screen and then clicking the mouse while 
the cursor is positioned directly over the note in question.

A note may be deleted by positioning the cursor over the note and pressing the Delete key
or SHIFT+D. You can also press the right mouse button and select the Delete item from the
menu that pops up.

Inserting a note is done by selecting a track, and positioning the cursor between two notes 
and clicking the left mouse button or pressing the Enter key.



Playing Music
To play music, you must have first configured Windows correctly so that it recognizes the 
music device you have installed in your computer. This may be an internal FM synthesizer 
card such as a Sound Blaster, or a MIDI interface card such as an MPU-401 which must be 
connected to a MIDI synthesizer. Please consult the Windows manual and the instructions 
that came with the card to do this correctly.

Once this has been done, Lyra will recognize the music device(s) in your computer. If you 
have more than one music device installed, then you will need to configure Lyra so that it 
knows which one you want to play music on. This is done with the Preferences command on
the File menu.

When you select the Play command under the Play menu, a new item, Stop, will appear 
on the menu bar at the top of the window. As the music is played, the current measure 
number is displayed in the go to button on the tape controls. You may stop playback at any
time by selecting the stop button. This will result in the music display returning to the point
where playing started. Selecting the goto button or selecting the Stop menu item will 
result in the music display staying at its current position. 

If your synthesizer does not play correctly, you may need to set up the track parameters or 
you may want to set the Filter.



Notes and Rests
Notes are the fundamental building blocks of any piece of written music. They represent 
the musical sounds made by an instrument. Each note has two basic pieces of information 
built into it: the length, which is determined by the shape; and pitch, which is determined 
by the position of the note on the musical staff.

Rests are used toshow that no sound is to be made for a given amount of time. The length 
of a rest is determined by its shape. A rest may be placed anywhere on the musical staff, 
but vertical placement does not affect the rest (it is just for making the music easier to 
read).

Here is a list of the notes and rests that Lyra uses:

 whole note and rest. Equal to four quarter notes.

 half note and rest. Equal to two quarter notes.

 quarter note andrest. Normally get one beat.

 eighth note and rest. Two are equal to one quarter note.

 sixteenth note and rest. Four are equal to one quarter note.

 thirty-second note and rest. Eight are equal to one quarter note.

 sixty-fourth note and rest. Sixteen are equal to one quarter note.



Accidentals
An accidental (also called a pitch modifier) is a term used to describe a group of symbols 
used to modify the pitch of a note. Lyra makes use of three accidentals:

 is the sharp symbol. It raises the pitch of a note half a step.

 is the flat symbol. It lowers the pitch of a note half a step.

 is the natural symbol. It is used to cancel the effect of the key signature. If the note would
normally have been sharped by the key signature, then the natural would lower the pitch 
half a step. If the note would have been flatted by the key signature, then the natural would 
raise the pitch half a step.



Length Modifiers
The length modifiers are used to change the length of a note or rest. Since a tie is not 
allowed to modify a rest, the combination of a rest and tie cannot be selected in Lyra. 
Otherwise, you may select any combination of length modifiers to modify a note or rest.

 this is the triplet modifier. It shortens the length of the note or rest slightly so that three 
of the same note or rest will be equal to two of the unmodified note or rest. For example, 
three triplet eighth notes equal two eighth notes.

 this is the dot modifier. It looks just like a period. In increases the length of a note or rest 
by one half. For example, a dotted quarter note equals one and a half quarter notes (or three
eighth notes).

    this is the tie modifier. It allows you to combine two notes together. The result is a note 
of the pitch of the first one, and a length of both notes combined. Tied notes are required to 
be of the same pitch.



Key Signature
The key signature is set at the beginning of a piece of music and is notated by a group of 
sharps or flats immediately after the treble and bass clefs. Here is an example of a key 
signature of four flats:

The key signature actually is a fairly complicated concept involving scales and tonality. For 
our purposes, it is a form of shorthand that lets us specify the notes of the scale that will 
automatically be sharped or flatted. A key signature of four flats means that all B, E, A, and 
D notes are to be flatted (if you will look carefully at the example above, the flats are 
positioned on those notes).

The key signature is changed by using the Key Signatures command in the Tools 
pulldown menu. A key signature can have up to 7 sharps or flats, but never a mixture of 
sharps and flats. The order of flats and sharps is strictly defined by convention; all you have
to do is to determine how many flats or sharps there are in the key signature and Lyra will 
correctly display it for you.



Time Signature
The time signature gives you two bits of information about how music is to be played: the 
basic rhythm, and what note length gets a single beat. This is indicated by two numbers, 
arranged one over the other on each clef. It is set by the Time Signature command in the 
Tools menu. 

The top number tells you how many beats there are per measure. This number is usually 
from 1 to 12.

The bottom number tells you what note length gets a beat. This ranges from 2 for a half 
note, 4 for a quarter note, to 8 for an eighth note. Other numbers such as 3, 5, 6, 7 are not 
permitted.

Here is an example of a time signature of 6/8:

This indicates that there are 6 beats per measure, and an eighth note gets a beat. In actual
practice, however, this is usually performed as a triplet rhythm of two beats of three eighth 
notes per beat. Occasionally it is performed as three beats of two eighth notes per beat.



MIDI Controllers
MIDI controllers are MIDI messages that are used to control various types of synthesizer 
functions that modify how music is played. Not all synthesizers respond to all controller 
messages in the same way. All controller messages are three hex bytes long: B0, the 
controller number, and the conroller value. The last two values must always be 7F or less.

Here is a list of the most common controllers; use the Controllers Dialog to set up a new 
controller. 

07    Main Volume 0=off 7F=maximum
0A    Pan (stereo position) 0=left, 3F=middle, 7F=right
40    Sustain (damper pedal) 0=off, 7F=on

An example of a controller to set the volume to maximum would be B0 07 7F.

A controller that sets the pan to middle would be B0 0A 3F.



The Purpose of the _default.lyr File
_default.lyr, which is present in the same directory as wlyra.exe, is a file that is 
automatically loaded into Lyra when the program starts up. _default.lyr is a standard Lyra 
file and can contain any of the things that a Lyra file normally has. Normally, though, you 
will not want it to contain any notes. You can fill the instrument table, set up the volumes, 
the master tempo, and the like with the values you usually use.

If you don't want to use the features of _default.lyr, simply delete it.



Volume Settings
Each track can have its own volume. This can be set using the track configure dialog box, 
using the volume tool in the toolbox, or setting up a controller. Probably the easiest method
is to use the track configure dialog box. If you want to vary the volume of a track as music 
is played, then use the toolbox to place standard volume markers in the music. Of course, 
volume markers affect only the track in which they are placed.

A volume controller is a special MIDI message that tells a synthesizer to change its master 
volume for a given channel. Just before playing music, Lyra sends a volume control 
message for each channel, using the value set in the track configure dialog box.

Most synthesizers respond to standard volume markers and a volume controller in thesame
way. More sophisticated ones will change the quality of sound produced rather than volume
with the standard volume markers. The reason for this is that Lyra uses velocity changes 
to implement volume markers. Most synthesizers simply interpret a larger velocity number 
to mean a louder sound. Some others, however, produce a different sound that may or may
not be louder. An example is the piano: when you hit a key harder, the sound is louder but 
it also is brighter and you may hear some other percussive sounds associated with the key 
hitting bottom.



The Menus
Select the Menu that you need information about:

File: commands that access the disk drive and printer
Edit: commands that are used to change the various parts of a music score
Tools: commands that duplicate the tool box.
Play: commands that affect how music is played.



File Menu
New: This command is used to clear the music score. It does not change the time or key 
signature, master tempo, or clear the annotation, instrument controller tables, or lyrics.

Open: Load in an existing music score from disk using this command.

Save: Save the music score as a file on disk.

Printer Setup: Select and configure the printer used to print music.

Print: Print music on the default printer. Before printing, set the    Note Display mode in 
the Preferences box to a mode other than compact.

Preferences: Modify certain parameters that change the way Lyra works. See the 
Preferences topic.

Exit: Quit Lyra and return to Windows. If the music score currently in memory has been 
changed, Lyra will first ask if you want to lose the changes.



Edit Menu
Undo: Undo a command that has changed the music score.

Copy: Copy the notes in a marked block into a temporary holding area that then can be 
inserted into music with the Paste command.

Cut: Copy the notes in a marked block into a temporary holding area and then delete the 
marked notes. The copied notes can then can be inserted into music with the Paste 
command.

Annotation: Use this command to enter any information about the music you wish, such 
as a copyright notice or directions on how the music is to be played. It will be saved with 
the music.

Lyrics: Enter and edit lyrics for track one; more information in the Lyrics Dialog Box topic.

Goto: Adjust the music score display so that the bar number you give is the first measure 
displayed.

Filter: Prevent Lyra from displaying and playing certain types of music information. See the
Filter topic.



Tools Menu
The Tools menu duplicates the tool box at the bottom of the screen. It provides an 
alternate way of selecting the various tools as well as listing the keyboard shortcut keys for 
each tool.

See the tool box topic for more information on how the individual tools work.



Play Menu
Play - see the Play Music topic.

Tempo - set the speed at which music is played as the number of quarter notes per 
minute.

Transpose - specify how much music will be transposed when it is played back in terms of 
half steps. For example, entering -4 will make the music be played 4 half steps lower. When
the transpose amount is not zero, then a check mark will appear on the menu to remind 
you when you play music.

All Notes Off - if you have stopped music playback and you find that notes remain on, use 
this command to turn them off. It sends note off messages for all channels and turns the 
the sustain controller off in all channels.



Empty Instrument Table Alert
This message means that the instrument table does not have any entries. Consequently, 
you cannot select an instrument to place it in the music score.

You can set up the instrument table by clicking the right mouse button while the cursor is 
positioned over the    Instrument tool or by pressing the SHIFT+I keys.

More information about the instrument table may be found in the Instrument table topic.



Empty Controller Table Alert
This message means that the controller table does not have any entries. Consequently, you
cannot select a controller to place it in the music score.

You can set up the controller table by clicking the right mouse button while the cursor is 
positioned over the Control tool or by pressing the SHIFT+C keys.

More information about the controller table may be found in the Controller table topic.



How to change instrument sounds
You can use the Track Setup dialog box to set a different instrument sound for each track. 
You will notice that an instrument assignment can be made only if the track assignment is 
not the same as another track. In other words, each track that has its own instrument 
sound must also have its own unique channel number.

If you wish to change the instrument sound for a track while music is playing, you will need 
to use the Instrument tool, which is discussed in the Toolbox topic.



Playing multiple instrument sounds
Music in Lyra is organized into eight tracks, and each of these tracks can be set up so that 
it has its own instrument sound.

First of all, the music device must be capable of playing more than one sound at the same 
time. The Sound Blaster and most recent MIDI synthesizers have this capabiltiy.

Secondly, you must determine what the program change numbers are that correspond to 
the instrument sounds you want to hear. The synthesizer manufacturer's manual should 
give you this information. This number must be entered into the Instrument box on the 
track setup dialog box.

Last of all, make sure that each track that has its own instrument sound has a unique 
channel number (also set up in the track setup dialog box).



Hexadecimal Numbers
Hexadecimal numbers are based on the number sixteen. Decimal numbers, which everyone
is familiar with, are based on the number ten. Each digit in a decimal number is a multiple 
of a power of ten. The first three powers of ten are 1, 10, and 100. The number 213 actually
means 3*1 plus 1*10 plus 2*100.

In hexadecimal (or hex for short), when you reach the number ten, there are new digits up 
to the number fifteen. This is how you count to sixteen: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, 
E, F, 10. Notice that the letters A through F represent the numbers ten through fifteen, and 
that 10 no longer means ten, but sixteen. To avoid confusion with regular decimal numbers,
hex numbers usually have a $ in front or an h behind, like this: $7F or 7Fh. Each hex digit is
a multiple of a power of sixteen. The first three powers of sixteen 1, 16, and 256. The hex 
number 35 is the same as 5*1 plus 3*16, or 53 decimal. The hex number BA is the same as 
10*1 plus 11*16 or 186 decimal.



 this is the Volume tool



 this is the Tempo tool



 this is the Instrument tool



 this is the octave tool



 this is the controller tool



 this is the sharp symbol



 this is the flat symbol



 this is the natural symbol



 this is the tie symbol



 this is the dot symbol



 this is the triplet symbol



Select a track by clicking on the box at the top right corresponding to the track you wish to 
select, or press CTRL+the track number key (such as CTRL+1 for track one).



The track parameters may be modified by clicking the right mouse button on the 
corresponding track box at the upper right, or pressing the SHIFT+CTRL keys with the key 
corresponding to the track (such as SHIFT+CTRL+3 for track 3).



A measure is a group of notes that last a certain number of beats (defined by the time 
signature) and is enclosed by vertical barlines on the music staff.



A music device can be an internal FM synthesis card such as the Sound Blaster, or an 
internal MIDI interface card that connects your computer to a MIDI synthesizer. Such a 
music device must be correctly installed in Windows.







A status byte is the first number in a group of numbers that is a MIDI message. This 
number is always greater than 127 (or 7F hex). All of the other numbers are less than 128 
(or 80 hex). The status byte identifies the type of message that follows, and the channel 
number. Types of messages include note, control change, program change, pitch wheel, 
and others.



There are 16 MIDI channels. Most MIDI messages can be assigned to a channel. Messages 
that change a controller or instrument sound (program change) will affect only a single 
channel. For example, if you send a message to set a piano sound on channel 2, then only 
notes in a track that has a channel assignment of 2 will be affected and sound like a piano.



A chord is a group of notes that sound simultaneously, usually producing a harmonious 
effect.



The Filters Dialog Box
How to get here: Select the    Filters command from the Edit menu.

When one of the boxes in this dialog box is checked, that musical symbol is not displayed 
or played. This can be used to improve legibility of a print-out or to disable instrument 
changes when you're trying to play a file that was created for another synthesizer.



The Controllers Dialog Box
How to get here: Press the SHIFT+C key or click the right mouse button on the controller
tool (see the Toolbox topic for more information about tools).

This table must be set with up the correct information before you can use a controller tool.

There is space for 16 controllers. First is the controller name; make it something that 
describes what the controller will do. The name can be up to 15 letters long.

Next is the controller data. This data is sent to the music device to control various things 
like the master volume stereo position (also known as pan), sustain pedal, etc. The 
controller data is entered as hexadecimal bytes. Each byte must be two digits long and 
followed by a space. For example, b0 07 00 is the controller data to set the master volume
to zero. See the MIDI Controllers topic for more information about the numbers to use.

You can enter multiple MIDI messages for a controller; the only restriction is that you 
cannot use system exclusives (they begin with F0 and end with F7).

Most MIDI status bytes have the channel number encoded in the second hex digit. When 
Lyra plays a controller, it replaces the channel number in the data area with the channel of 
the track in which the controller is entered. For example, entering B0 07 3F
produces the same result as B7 07 3F.

You will need to consult your synthesizer manual for the correct numbers to use here. 
Remember that the Track Configure dialog box lets you set the most frequently used 
controllers.

More information about volumes in Volume Settings and controllers in MIDI Controllers.



The Volumes Dialog Box
How to get here: Press the SHIFT+V key or click the right mouse button on the Volume 
tool (see the Toolbox topic for more information about tools).

Here is where you can set the actual volume associated with each volume symbol. The 
volume must be a number from 0 to 127. Lyra plays volumes as changes in the note 
velocity. If you wish to use a control volume change, use the Control tool. More information 
about volumes in Volume Settings.



The Instruments Dialog Box
How to get here: Press the SHIFT+I keys or click the right mouse button on the 
Instrument tool (see the Toolbox topic for more information about tools).

The Instruments Dialog lets you modify the instrument names and the program change 
numbers associated with each instrument. There is space for 16 instruments, arranged in 
two columns. Within each column, the first space is for the instrument name. The second 
space (titled Pgm) is for the program change number.

The name that you give is entirely up to you. Only the first 15 letters in the name will be 
saved. If the name is blank or starts with a space, that instrument will not be listed when 
the the instrument tool is clicked on.

The program change number is the actual number that is sent to your synthesizer to 
change the sound that it makes. This number depends on the synthesizer and you will have
to consult the manual that came with your synthesizer to determine what numbers to use. 
Do not enter a program change number greater than 127.

Lyra assumes that the first program change number is zero; some synthesizers start at one.
If your synthesizer is one that starts at 1, click on the radio button at the bottom of the list 
titled Patches start at 1. This will cause 1 to be subtracted from each program change 
number when you press the OK button.



A multi-timbral synthesizer is one that is capable of playing more than one instrument 
sound at a time.



Configuring a Track
How to get here: Click the right mouse button on a track box or press Ctrl+Shift+a 
number key (1-8).

Each track can be configured so that it has a unique MIDI channel, volume, stereo position 
(pan), instrument (program change), and transpose offset. This makes it possible for you to
play music on a multi-timbral synthesizer that sounds like a small band playing.

You can call up the track configure dialog box by clicking the right mouse button on one of 
the track boxes at the right upper corner of the window, or by pressing the SHIFT and CTRL 
keys with the number key corresponding to the desired track (such as SHIFT+CTRL+2 for 
track two).

Following is a description of each line in the Track Setup dialog box.

Channel - This can be any number from 1 to 16. This is the MIDI channel for the track. 
More than one track can have the same channel, but only the first track can be configured 
for volume, position, and instrument.

Clef - This will be used in future versions to permit multiple staves.

Transpose - The number given here is the number of half steps that are added (or 
subtracted) to each note pitch in a track when music is played. This is useful for 
transcribing music for an instrument whose concert pitch does not correspond to the 
written pitch.

Master Volume - Lyra sends MIDI control messages for each track to set a master volume 
for each track; 0 corresponds to complete silence, and 127 is maximum. More information 
about volumes in Volume Settings.

Stereo Position - Each track may be configured to play through the left or right speaker, 
or somewhere between. Zero corresponds to left, and 127 to right, and 63 to exactly 
between.

Instrument - The number entered here is sent as a MIDI program message just before 
music is played. Program messages are used to change the instrument sound that a 
synthesizer makes; you must enter the number corresponding to the sound you want. 
Consult the synthesizer manual for the needed information.

The Master Volume, Stereo Position, and Instrument lines will be disabled if the Channel 
number is the same as one used in a previous track. For example, if tracks 1 and 2 both are
set to channel 2, then you will be able to modify those lines only in track 1. To remind you 
of this fact, a message (set up in track 1) will appear after the channel number for track 
2.



Signatures Dialog Box
How to get here: Select the key or time signature tool from the tool box.

This dialog box is used to change the key signature or time signature. This version does not
support multiple key or time signatures within a music file (this is planned for future 
versions!).

The key signature is entered as a number followed by either F (for flats) or S for sharps. For
example, the key signature of 3 sharps would be entered as 3S. See the key signature topic
for more information.

The time signature is entered as a simple fraction (such as 3/4, 4/4). More information is in
the time signature topic.



Tempo Dialog Box
How to get here: Select the Tempo command from the Play menu.

Here is where you cange change the speed at which music is played (tempo). The number 
you enter is the number of quarter notes per minute. Entering 120 will result in music being
played at the speed of 120 quarter notes per minute (or two quarter notes per second).

The tempo set here is called the master tempo. It is the tempo effect at the start of music. 
If you use the tempo tool to change the music after the start, the new tempo takes 
precedence.



Transpose Dialog Box
How to get here: Select the Tranpose command from the Play menu.

Use this dialog box to transpose all tracks when music is played. The number you enter is 
the number of semitones that music will be transposed. For example, entering -4 will result 
in music being played 4 semitones lower.

If you wish to transpose only certain tracks, then use the Track Configure dialog box.



Preferences Dialog Box
How to get here: Select the Preferences command from the File menu.

This is where you modify certain parameters that change the way Lyra operates.

Note gray shade: Enter a number (or adjust the slider) to change the intensity of the gray
used to display unselected notes. The value 0 corresponds to black, and 255 is white. 164 
is the value that Lyra uses by default. You can also use this to completely turn off 
unselected notes by entering the value 255. If you change the value of this box by typing a 
new value, and then press the Enter key, you will find that the new value did not get 
entered as intended. You can fix this by pressing the Tab key before the Enter key or 
selecting the OK button.

Music Device: This combo box contains all the names of the installed music devices. Just 
select the one you want. If no device has been installed, (none) will appear and you will 
not be able to open the combo box. This version also includes a FILE device; this is used 
for debugging purposes and will be deleted in the future. The MIDI Mapper device is not 
yet functional.

Note Display: This combo box allows you to select the way music will be displayed. You 
can select Compact, which is default display; each note length is given the same space. 
The remaining selections space notes and rests according to their length. A longer note is 
given more space.

Persistent Note Modifiers: When this box is marked with an 'X', then the note pitch and 
length modifiers (sharp, natural, flat, triplet, dot, tie) remain selected after a note is placed 
on the score. If it is not marked, then the note and pitch modifiers are cleared after a note 
has been placed on the score.

Animate Playback: When this box is marked with an 'X', Lyra will update the music 
display as it is played so you can follow along.

Timer Resolution: This number controls how accurate the timer is that is used to play the 
music. The smaller the the number, the higher the accuracy. However, the smaller the 
number, the more processing time required of the CPU, which slows everything else down. 
You may find that a slower machine requires a larger number to play music at all. Music 
that is dense and has a lot of fast notes will require a smaller number. Valid values are 1 to 
32; a recommended starting number is 16.



The Lyrics Dialog Box
How to get here: Select the Lyrics command from the Edit menu.

Lyrics may be added to a song by the use of this dialog box. This version allows lyrics only 
for track one, and they are displayed above the music. Simply position the music display so
that it is at bar 1 or the first note in track 1. Call up this dialog box and type in the lyrics. Be
sure to put a space between all syllables that you want assigned to separate notes. For 
example, typing heavenly light as hea- ven- ly light will put the words on four different 
notes, whereas heavn- ly light will put the words on only three notes. If you want to skip a
note (no word for it), just type in an extra space.

Editing lyrics requires only that the words be currently displayed. If no words are displayed, 
move back in the music until words appear. The lyric editor dialog box will contain only 
those words that start with what is displayed. Make any changes you want, select the OK 
button, and you will see the display changed accordingly.

You can turn lyric display off by selecting the Lyric filter.



You must first select a Note Display mode other than Compact from the Preferences 
dialog before printing music.



Select the Ok button to erase all the notes in memory; this does not erase the annotation, 
instrument, controller, or volume tables.



The wlyra.ini File
The wlyra.ini file contains information that tells Lyra how to configure itself. All of the data 
in this file is set by the Preferences dialog box. This file is always kept in the same directory
as wlyra.exe.

Here is a list of the file and the possible values that each variable can have:

NoteGrayShade: the shade of gray used to display notes that are not selected. 0=black, 
255=white
MusicDeviceName: the name of the device used to play music on.
DisplayType: the number of bars of music displayed on the screen;

COMPACT: the music displayed with as little space between notes as possible
2 BARS: two bars per screen
3 BARS: three bars per screen
4 BARS: four bars per screen

ToolsPositionX: the horizontal position of the toolbox.
ToolsPositionY: the vertical position of the toolbox.
PersistentNoteModifiers: set to ON if pitch and length note modifiers remain selected 
after a note is entered on the music score; otherwise set to OFF.
AnimatePlayback: set to ON if you want Lyra to update the music display while music is 
being played so you can follow along; otherwise set to OFF.
TimerResolution: the resolution of the timer used to play music; may be set to 1 through 
32.



The Annotation Dialog Box
How to get here: Select the Annotation item from the Edit menu.

Use this to enter information about the title, author, copyright, and any other text about 
the music. This will all be saved with the music. Future versions will make use of this 
information when printing music.

Do not use the tilde (~) character; this is used by Lyra to mark the end of each section of 
text in the annotation.



The Paste Command
The Paste command is used to insert music already stored in a temporary holding area by 
the use of the Copy or Cut commands. Place the cursor over a note and press the Ctrl+V 
or Shift+Insert keys or press the right mouse key and select the Paste item from the 
menu that pops up. The inserted music follows immediately after the note that was under 
the cursor.

You can use this command to move music from one track to another. To move music from 
track one to track two, select track one, select the desired notes, select track two and 
paste at the desired spot.



A block is marked by using the Select tool from the Tool Box.



Compatibility with Previous Versions
Lyra for Windows can read music files produced by previous versions for the Tandy Color 
Computer (you just need to transfer the files to a PC formatted disk) and the DOS version, 
PC-Lyra. This version will also write files that are at least partially usable by previous 
versions. The music data format is unchanged but much of the rest of the data (such as 
annotation, instrument and controller tables) is new and will not transfer. A major change is
planned in the near future which will result in a completely new format that will not be 
readable by previous versions.



Program History
Lyra was first released for the Tandy Color Computer in 1985 and was marketed by Speech 
Systems. It was written entirely in assembly language, giving it the advantage of very small
size but also the disadvantage of being hard to fix and update. The program sported a 
mouse driven user interface and could interface with a MIDI synthesizer with the addition of
a two wire cable.

PC-Lyra was released in 1989 and marketed initially by MusicWare. In 1991 Covox included 
it with their PC sound card, the Sound Master II. It was written in C. Its music files are pretty
much identical to the Color Computer version's.

Lyra for Windows was released in 1993 and marketed as Shareware by the author. It is 
written in Pascal.

The future of Lyra lies primarily in the Windows version, though the DOS version may see 
improvements if there are enough people who want them.




